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Introduction

This guide will take you through the hardware installation and configuration of ABB ACS Drives and PLC in order to
prepare for Modbus TCP control. ABB-specific ready-made function blocks and visualizations from the
PS553-DRIVES library will be used for the control of the drives. While the guide is applicable to all AC500 PLCs and
all Modbus TCP compatible ABB ACS drives, the example is built up with an AC500-eCo PM554-ETH PLC and an
ACS850 drive.

Note! The material in this application might need to be adapted according to actual equipment and function
before it is used. Testing of the equipment must always be performed by the responsible start-up person according
to current legislation before the equipment is placed in service. ABB does not take any responsibility for possible
damage caused by using the material in this application (shown examples, data, project tools, etc.).

Safety instructions
Follow all safety instructions delivered with the used components:

e Read the complete safety instructions for the used drive before you install, commission or use the drive.
The complete safety instructions are given at the beginning of the drives user’s manual (e.g. for ACS850:
3AUA0000045496 [English]).

e Read all safety and installation instructions of the used PLC. See the online help in CoDeSys (Help >
Contents > Target System > AC500 / S500 > Introduction > Overview > Regulations).

Limitations
The following limitations are valid for this guide:

e General
0 Allinstructions in this guide are based on default settings in PLC and drives
0 PS501 Control Builder Plus version 2.2.0 or later
0 The drive must be equipped with a Modbus TCP adapter
e Function block and visualization library PS553-DRIVES compatibility
0 Communication profile: ABB Drives (classic) or ABB Drives enhanced
0 Drive types: All Modbus TCP compatible ABB ACS drives
0 Application types: Speed/Frequency control or Torque control
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Hardware physical connection
In the following chapter, physical connection of the hardware will be explained.

Fieldbus modules for ABB drives
e FENA-01 (Used with for instance ACS355)
e FENA-11 (Used with for instance for ACS355,ACSM1,ACS850,ACQ810 and ACS880)
e RETA-01, RETA-02 (Used with for instance of ACS550 and ACS800)

Common recommendations
Note! The following points are only recommendations and no general rules.

e Use Switch or Router
e Cable type:
0 Use only cables with 4 pair CAT5 cables.

RJ45 connector.

Two general variants are distinguished for the pin assignment of the normally used RJ45 connectors. EIA/TIA 568
version A and version B, where the wiring according to EIA/TIA 568 version B is commonly used.

Connector pin assignment.
Today RJ45 connectors are accepted as a standard for the cabling of 10 Mbits/s networks as well for 100 Mbits/s.
Generally the same pin configuration is used for both the variants.
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Installation examples.

The topology of an Ethernet network is like a star or tree structure. Up to two stations can be connected to each
segment where active distribution devices like hubs or switches are also considered as a station. The following
figure shows an example of a simple Ethernet network.
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Drive configuration
Drives need to be equipped with Modbus TCP adapter according to actual drive type.

The following drive configuration steps will adapt the drive to Modbus TCP control based on ABB-specific drives
library PS553-DRIVES.

Drive parameters can be set from the drive’s control panel or from drive-specific PC tool:

e DriveWindow Light for ACS355 and ACS550,
e DriveStudio for ACS850 and ACSM1,
e Drive Composer for ACS880 and DriveWindow for ACS800.

Note! All parameter settings are based on drive default settings. If the drive has been parameterized previously,
return to default settings before continuing. It can be done by:

e Changing macro (and then changing back again) in parameter 99.02 for ACS310, ACS355 and ACS550.
e Setting parameter 99.03 APPLIC RESTORE to YES in ACS800.

e Setting parameter 16.04 Param restore to Restore defs in ACS850 and ACSM1.

e Setting parameter 96.06 Parameter restore to Restore defaults in ACS880.
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Starting up ACS355 drives with FENA-01 Ethernet adapter

1.
2.

Power up the drive.

Enable the communication between the adapter module and the drive by setting parameter 98.02 COMM
PROT SEL to EXT FBA.

Set the FENA-01/-11 configuration parameters in group 51. At the minimum, select the communication
protocol and profile with parameter 51.02 and configure the network settings with parameters 51.03...51.13.
With parameter 30.18 COMM FAULT FUNC, select how the drive reacts to a fieldbus communication break.
With parameter 30.19 COMM FAULT TIME, define the time between communication break detection and the
selected action.

Define the process data transferred to and from the drive in parameter groups 54 and 55.
Note! The adapter module sets the Status word and actual value automatically in parameters 54.01 and 54.02,
and Control word and reference in parameters 55.01 and 55.02.

Validate the settings made in parameter groups 51, 54 and 55 by setting parameter 51.27 FBA PAR REFRESH to
REFRESH.

8. Set the relevant drive control parameters to control the drive according to the application.

Minimum required parameter settings (based on factory default settings)

Parameter | Description Setting Comment

98.02 COMM PROT SEL EXT FBA Activates fieldbus module

51.01 FBA TYPE ETHERNET Type of the connected fieldbus module. Read only

51.02 PROTOCOL / Oor1l 0=ModbusTCP ABB Drives profile classic

PROFILE 1= ModbusTCP ABB Drives profile enhanced

51.03 COMMRATE 0 Bit rate for the Ethernet interface.

51.04 IP CONFIGURATION | O (Static IP) Sets the method for configuring the IP address.
0 = Disable DCHP —>static IP address

51.05 IP ADDRESS 1 [IP address 1] | First part of IP address. E.g. 192

51.06 IP ADDRESS 2 [IP address 2] | Second part of IP address. E.g. 168

51.07 IP ADDRESS 3 [IP address 3] | Third part of IP address. E.g. 0

51.08 IP ADDRESS 4 [IP address 4] | Fourth part of IP address. E.g. 11

51.09 SUBNET CIDR [Subnet mask] | Subnet mask. E.g. 24 = 255.255.255.0

51.20 MODBUS/TCP 20 *) Timeout = (MODBUS/TCP Timeout value) * 100

TIMEOUT milliseconds.*) e.g. 20 = 2 seconds

51.21 TIMEOUT MODE Oor1l 0 = none; 1 = any message,
(NOT 2= control read/write as control and references are
only written after changes)

51.22 WORD ORDER 0 Selects in which order 16 bit registers of 32 bit parameters
are transferred. 0 = HILO

51.27 FBA PAR REFRESH 1 Updates fieldbus settings (groups 51 to 55)
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Parameter | Description Setting Comment

10.01 EXT 1 COMMANDS COMM Fieldbus interface as source for start and stop

11.02 EXT1/EXT2 SEL COMM Fieldbus interface as source to switch to EXT2

11.03 REF1 SELECT COMM Fieldbus interface as source for speed reference

16.04 FAULT RESET SEL COMM Fieldbus interface as source for fault reset

11.05 REF1 MAX Max speed/frequency scaling value . Must be less or equal
to drive parameter max speed/frequency.

Optional parameter settings

Parameter | Description Setting Comment

30.18 COMM FAULT FUNC | FAULT How the drive reacts to a fieldbus communication break.

30.19 COMM FAULT TIME | Default:. 3s Time between communication break detection and the

selected action.

More actual values or parameters to be read from drive to PLC if “ABB Drives profile ENHANCED" is used

(optional)

Parameter | Description Setting Comment

54.03 .. Actual value or GGii GG = parameter group, ii = parameter index
54.10 parameter of drive e.g. 0104 = actual current; 0145 = motor temp
51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 55)

More parameters to be written from PLC to drive if “ABB Drives profile ENHANCED” is used (optional)

Parameter | Description Setting Comment

55.03.. Parameter of drive GGii GG = parameter group, ii = parameter index

55.10 e.g. 2202 = acceleration time 1

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 55)
Modbus TCP -10- PLC and drives Integration / 05.2013
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Starting up ACS850, ACQ810 drives with FENA-11 Ethernet module

1. Power up the drive.

2. Enable the communication between the adapter module and the drive by setting parameter 50.01 FBA enable
to Enable.

3. With parameter 50.02 Comm loss func, select how the drive reacts to a fieldbus communication break. Note
that this function monitors both communication between the fieldbus master and the adapter module and
communication between the adapter module and the drive.

4. With parameter 50.03 Comm loss t out, define the time between communication break detection and the
selected action.

5. Select application-specific values for parameters 50.04...50.11. Examples of appropriate values are shown in
the tables below.

6. Set the FENA-01/11 configuration parameters in group 51. At the minimum, select the communication
protocol and profile with parameter 51.02 and configure the network settings with parameters 51.03...51.13.

7. Define the process data transferred to and from the drive in parameter groups 52 and 53.
Note! The adapter module automatically sets the communication profile-specific virtual address for the Status
word in parameter 52.01 and for the Control word in parameter 53.01.

8. Validate the settings made in parameter groups 51, 52 and 53 by setting parameter 51.27 FBA par refresh to
Refresh.

9. Set the relevant drive control parameters to control the drive according to the application.

Minimum required parameter settings (based on factory default settings)

Parameter | Description Setting Comment

50.01 FBA ENABLE 1 Enables communication between the drive and fieldbus
adapter. 1 = Enable.

51.01 FBA TYPE Ethernet Displays the type of the connected fieldbus adapter type.
Read only

51.02 PROTOCOL / Oorl 0 = Modbus TCP ABB Drives profile classic,

PROFILE 1 = Modbus TCP ABB Drives profile enhanced

51.03 COMMRATE 0*) Bit rate for the Ethernet interface.
*) e.g. 0 = Auto-negotiate.

51.04 IP CONFIGURATION | O (Static IP) Sets the method for configuring the IP address.
0 = Disable DCHP —>static IP address

51.05 IP ADDRESS 1 [IP address 1] First part of IP address. E.g. 192

51.06 IP ADDRESS 2 [IP address 2] Second part of IP address. E.g. 168

51.07 IP ADDRESS 3 [IP address 3] Third part of IP address. E.g. 0

51.08 IP ADDRESS 4 [IP address 4] Fourth part of IP address. E.g. 11

51.09 SUBNET CIDR [Subnet mask] | Subnet mask. E.g. 24 = 255.255.255.0

51.27 FBA PAR REFRESH 1 Updates fieldbus settings (groups 51 to 53)
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Parameter | Description Setting Comment

10.01 EXT1 START FUNC FB Fieldbus interface as source for start and stop

10.10 FAULT RESET SEL P.02.22 bit 8 Fieldbus interface as source for fault reset

12.01 EXT1/EXT2 SEL P.02.22 bit 15 Fieldbus interface as source to switch to EXT2 control
location

19.01 SPEED SCALING [Scale max] Max speed/frequency scaling value . Must be less or equal
to drive parameter max speed/frequency.

21.01 SPEED REF1 SEL FBA refl Fieldbus interface as source for speed reference

Optional parameter settings

Parameter | Description Setting Comment

50.02 COMM LOSS FUNC | FAULT Defines the reaction of the drive upon a
communication break. (0 =none, 1=fault,...)

51.20 MODBUS/TCP 20 *) Timeout = (MODBUS/TCP Timeout value) * 100

TIMEOUT milliseconds. *) e.g. 20 = 2 seconds

51.21 TIMEOUT MODE Oor1l 0 = none; 1 = any message, (NOT 2= control read/write as
control and references are only written after changes)

51.22 WORD ORDER 0 Selects in which order 32 bit parameters are transferred.
0=HILO

51.27 REFRESH SETTINGS | 1 Updates fieldbus settings (groups 51 to 53)

More actual values or parameters to be read from drive to PLC if “ABB Drives profile ENHANCED" is used

(optional)

Parameter | Description Setting Comment

52.01.. Actual value or GGii GG = parameter group, ii = parameter index
52.12 parameter of drive e.g. 0104 = actual current;

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 53)

More parameters to be written from PLC to drive if “ABB Drives profile ENHANCED” is used (optional)

Parameter | Description Setting Comment

53.01.. Parameter of drive GGii GG = parameter group, ii = parameter index

53.12

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 53)
Modbus TCP -12- PLC and drives Integration / 05.2013
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Starting up ACS880 drives with FENA-11 Ethernet adapter

1. Power up the drive.

2. Enable the communication between the adapter module and the drive by setting parameter 50.01 FBA A
Enable to Enable.

3. With parameter 50.02 FBA A comm loss func, select how the drive reacts to a fieldbus communication break.
Note that this function monitors both communication between the fieldbus master and the adapter module
and communication between the adapter module and the drive.

4. With parameter 50.03 FBA A comm loss t out, define the time between communication break detection and
the selected action.

5. Select application-specific values for the rest of the parameters in group 50, starting from 50.04. Examples of
appropriate values are shown in the tables below.

6. Set the FENA-11 configuration parameters in group 51. At the minimum, select the communication protocol
and profile with parameter 51.02 Protocol/Profile and configure the network settings with parameters
51.03...51.13.

7. Define the process data transferred to and from the drive in parameter groups 52 and 53.
Note! The adapter module automatically sets the communication profile-specific virtual address for the Status
word in parameter 52.01 and for the Control word in parameter 53.01.

8. Validate the settings made in parameter groups 51, 52 and 53 by setting parameter 51.27 FBA par refresh to

Refresh.

9. Set the relevant drive control parameters to control the drive according to the application.

Minimum required parameter settings (based on factory default settings)

Parameter | Description Setting Comment

50.01 FBA A enable Enable Activates fieldbus module

51.01 FBA TYPE Ethernet Displays the type of the connected fieldbus
adapter type. Read only

51.02 Protocol / Profile 1 Application protocol and communication profile.

51.03 COMMRATE 0 Bit rate for the Ethernet interface.

51.04 IP CONFIGURATION | O Sets the method for configuring the IP address.

51.05 IP ADDRESS 1 [IP address 1] | First part of IP address. E.g. 192

51.06 IP ADDRESS 2 [IP address 2] | Second part of IP address. E.g. 168

51.07 IP ADDRESS 3 [IP address 3] | Third part of IP address. E.g. 0

51.08 IP ADDRESS 4 [IP address 4] | Fourth part of IP address. E.g. 11

51.09 SUBNET CIDR [Subnet mask] | Subnet mask. E.g. 24 = 255.255.255.0

51.20 MODBUS/TCP 20 *) Timeout = (MODBUS/TCP Timeout value) * 100

TIMEOUT milliseconds. *) e.g. 20 = 2 seconds

51.22 WORD ORDER 0 Selects in which order 16 bit registers of 32 bit
parameters are transferred. 0 = HILO

51.27 FBA par refresh Configure Updates fieldbus settings (groups 50 to 57)
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Parameter | Description Setting Comment
19.11 Ext1/Ext2 selection MCW Bitl11 Fieldbus interface as source to switch to EXT2
(06.01) control location

20.01 Ext 1 commands Fieldbus A Fieldbus interface as source for start and stop

22.11 Speed refl selection | FB A refl Fieldbus interface as source for speed reference

31.11 Fault reset selection | P.06.01 bit 7 Fieldbus interface as source for fault reset

46.01 Speed scaling [Scale max] Max speed/frequency scaling value . Must be less
or equal to drive parameter max
speed/frequency.

Optional parameter settings

Parameter | Description Setting Comment

50.02 FBA A comm loss [optional] Defines the reaction of the drive upon a

func communication break. (0 =none, 1=fault,...)
50.03 FBA A comm. loss 20 %) Fieldbus A communication break supervision time.
timeout * 100 milliseconds. *) e.g. 20 = 2 seconds

51.21 TIMEOUT MODE Oor1l 0 =none; 1 = any message,
(NOT 2= control read/write as control and
references are only written after changes)

51.22 WORD ORDER 0 Selects in which order 16 bit registers of 32 bit
parameters are transferred. 0 = HILO

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 50 to 53)

More actual values or parameters to be read from drive to PLC if “ABB Drives profile ENHANCED" is used

(optional)

Parameter | Description Setting Comment

52.01.. Actual value or GGii GG = parameter group, ii = parameter index
52.12 parameter of drive e.g. 0104 = actual current;

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 53)

More parameters to be written from PLC to drive if “ABB Drives profile ENHANCED" is used (optional)

Parameter | Description Setting Comment

53.01.. Parameter of drive GGii GG = parameter group, ii = parameter index

53.12

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 53)
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Starting up ACSM1 drives with FENA-11 Ethernet adapter

1. Power up the drive.

2. Enable the communication between the adapter module and the drive by setting parameter 50.01 FBA
ENABLE to Enable.

3. With parameter 50.02 COMM LOSS FUNC, select how the drive reacts to a fieldbus communication break.
Note that this function monitors both communication between the fieldbus master and the adapter module
and communication between the adapter module and the drive.

4. With parameter 50.03 COMM LOSS T OUT, define the time between communication break detection and the
selected action.

5. Select application-specific values for parameters 50.04...50.11. Examples of appropriate values are shown in
the tables below.

6. Set the FENA-11 configuration parameters in group 51. At the minimum, select the communication protocol
and profile with parameter 51.02 and configure the network settings with parameters 51.03...51.13.

7. Define the process data transferred to and from the drive in parameter groups 52 and 53.
Note! The adapter module automatically sets the communication profile-specific virtual address for the Status
word in parameter 52.01 and for the Control word in parameter 53.01.

8. \Validate the settings made in parameter groups 51, 52 and 53 by setting parameter 51.27 FBA PAR REFRESH to

REFRESH.

10. Set the relevant drive control parameters to control the drive according to the application.

Minimum required parameter settings (based on factory default settings)

Parameter | Description Setting Comment

50.01 FBA ENABLE Enable Activates fieldbus module

51.01 FBA TYPE Ethernet Displays the type of the connected fieldbus
adapter type. Read only

51.02 PROTOCOL / Oorl 0 = Modbus TCP ABB Drives profile classic,

PROFILE 1 = Modbus TCP ABB Drives profile enhanced

51.03 COMMRATE 0*) Bit rate for the Ethernet interface.
*) e.g. 0 = Auto-negotiate.

51.04 IP CONFIGURATION | O (Static IP) Sets the method for configuring the IP address.
0 = Disable DCHP —>static IP address

51.05 IP ADDRESS 1 [IP address 1] | First part of IP address. E.g. 192

51.06 IP ADDRESS 2 [IP address 2] | Second part of IP address. E.g. 168

51.07 IP ADDRESS 3 [IP address 3] | Third part of IP address. E.g. 0

51.08 IP ADDRESS 4 [IP address 4] | Fourth part of IP address. E.g. 11

51.09 SUBNET CIDR [Subnet mask] | Subnet mask. E.g. 24 = 255.255.255.0

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 50 to 53)
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Parameter | Description Setting Comment

10.01 EXT1 START FUNC FBA Fieldbus interface as source for start and stop

12.01 EXT1/EXT2 SEL P.02.12 bit 15 | Fieldbus interface as source to switch to EXT2
control location

24.01 SPEED REF1 SEL FBA REF1 Fieldbus interface as source for speed reference

10.08 FAULT RESET SEL P.02.12 bit 8 Fieldbus interface as source for fault reset

25.02 SPEED SCALING [Scale max] Max speed/frequency scaling value . Must be less
or equal to drive parameter max
speed/frequency.

Optional parameter settings

Parameter | Description Setting Comment
50.02 COMM LOSS FUNC FAULT Defines the reaction of the drive upon a
communication break. (0 =none, 1=fault,...)
51.20 MODBUS/TCP 20 %) Timeout = (MODBUS/TCP Timeout value) * 100
TIMEOUT milliseconds. *) e.g. 20 = 2 seconds
51.21 TIMEOUT MODE Oor1l 0 = none; 1 = any message, (NOT 2= control

read/write as control and references are only
written after changes)

51.22 WORD ORDER 0 Selects in which order 32 bit parameters are
transferred. 0 = HILO
51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 50 to 53)

More actual values or parameters to be read from drive to PLC if “ABB Drives profile ENHANCED"” is used
(optional)

Parameter | Description Setting Comment

52.01.. Actual value or GGii GG = parameter group, ii = parameter index
52.12 parameter of drive e.g. 0104 = actual current;

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 53)

More parameters to be written from PLC to drive if “ABB Drives profile ENHANCED"” is used (optional)

Parameter | Description Setting Comment

53.01.. Parameter of drive GGii GG = parameter group, ii = parameter index
53.12

51.27 FBA PAR REFRESH REFRESH Updates fieldbus settings (groups 51 to 53)
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Starting up ACS550 with RETA-01 Ethernet adapter.

1.
2.

7.
8.

Power up the drive.

Enable the communication between the adapter module and the drive by setting parameter 98.02 COMM
PROT SEL to EXT FBA.

With parameter 30.18 COMM FAULT FUNC, select how the drive reacts to a fieldbus communication break.
With parameter 30.19 COMM FAULT TIME, define the time between communication break detection and the
selected action.

Set the RETA-01 configuration parameters in group 51. At the minimum, set the required IP address in
parameters 51.04...51.07, Subnet mask in parameters 51.08...51.11 and 51.16 Protocol to 0 (Modbus TCP,
ABB Drives profile).

Define the process data transferred to and from the drive in the RETA-01 configuration parameter group 51.
Note! The Status Word, Actual Speed, Control Word and Speed Reference are fixed in ACS550 and not
necessary to set.

Validate the settings made in parameter group 51 by setting parameter 51.27 FBA PAR REFRESH to REFRESH.
Set the relevant drive control parameters to control the drive according to the application.

Minimum required parameter settings (based on factory default settings)

Parameter | Description Setting Comment

98.02 COMM PROT SEL EXT FBA Activates fieldbus communication

51.01 FBA TYPE ETHERNET Displays the type of the connected fieldbus adapter
module. Read only

51.02 COMM RATE 0 (Example) Defines the baud rate of the Ethernet interface.
0 = Auto-negotiate.

51.03 DHCP 0 (Example) DHCP Enable / Disable . 0 = Disable

51.04 IP ADDRESS 1 [IP address 1] First part of IP address. E.g. 192

51.05 IP ADDRESS 2 [IP address 2] Second part of IP address. E.g. 168

51.06 IP ADDRESS 3 [IP address 3] Third part of IP address. E.g. 0

51.07 IP ADDRESS 4 [IP address 4] Fourth part of IP address. E.g. 11

51.08 SUBNET MASK 1 [Subnet mask 1] | First part of Subnet mask. E.g. 255

51.09 SUBNET MASK 2 [Subnet mask 2] | Second part of Subnet mask. E.g. 255

51.10 SUBNET MASK 3 [Subnet mask 3] | Third part of Subnet mask. E.g. 255

51.11 SUBNET MASK 4 [Subnet mask 4] | Fourth part of Subnet mask. E.g. 0

51.16 PROTOCOL 0 Selects the application protocol and communication
profile. 0 = Modbus/TCP

51.17 MODBUS TIMEOUT | 20 *) Timeout = (MODBUS/TCP Timeout value) * 100
milliseconds. *) e.g. 20 = 2 seconds

51.27 FBA PAR REFRESH 1 Validates any changed adapter module configuration
parameter setting .After refreshing, the values reverts
automatically to done.
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Parameter | Description Setting Comment

10.01 EXT 1 COMMANDS | COMM Fieldbus interface as source for start and stop

11.02 EXT1/EXT2 SEL COMM Fieldbus interface as source to switch to EXT2

11.03 REF1 SELECT COMM Fieldbus interface as source for speed reference

11.05 REF1 MAX [Scale max] Max speed/frequency scaling value . Must be less or
equal to drive parameter max speed/frequency.

16.04 FAULT RESET SEL COMM Fieldbus interface as source for fault reset

Optional parameter settings

Parameter | Description Setting Comment

30.18 COMM FAULT FAULT How the drive reacts to a fieldbus communication break.

FUNC

30.19 COMM FAULT TIME | 3.0 s Example Time between communication break detection and the
selected action.
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Starting up ACS800 drives with RETA-01 Ethernet adapter

1. Power up the drive.

2. Enable the communication between the adapter module and the drive by setting parameter 98.02 COMM.
MODULE LINK to FIELDBUS.

3. With parameter 30.18 COMM FLT FUNC, select how the drive reacts to a fieldbus communication break.

With parameter 30.19 MAIN REF DS T-OUT, define the time between communication break detection and the
selected action.

5. Set the RETA-01 configuration parameters in group 51. At the minimum, set the required IP address in
parameters 51.04...51.07, Subnet mask in parameters 51.08...51.11 and 51.16 Protocol to 0 (Modbus TCP).

6. Define the process data transferred to and from the drive in the RETA-01 configuration parameter group 51.
Note! The Status Word, Actual Speed, Control Word and Speed Reference are fixed in ACS550 and not
necessary to set.

7. Validate the settings made in parameter group 51 by setting parameter 51.27 FBA PAR REFRESH to REFRESH.

8. Set the relevant drive control parameters to control the drive according to the application.

Minimum required parameter settings (based on factory default settings)

Parameter | Description Setting Comment
98.02 COMM. MODULE FIELDBUS Activates fieldbus module
LINK

98.07 COMM PROFILE ABB DRIVES Communication profile “ABB Drives”

51.01 FBA TYPE ETHERNET Displays the type of the connected fieldbus adapter
module. Read only

51.02 COMM RATE 0%*) Defines the baud rate of the Ethernet interface.
*) e.g. 0 = Auto-negotiate.

51.03 DHCP 0%*) DHCP Enable / Disable. O = Disable — static IP address

51.04 IP ADDRESS 1 [IP address 1] First part of IP address. E.g. 192

51.05 IP ADDRESS 2 [IP address 2] Second part of IP address. E.g. 168

51.06 IP ADDRESS 3 [IP address 3] Third part of IP address. E.g. 0

51.07 IP ADDRESS 4 [IP address 4] Fourth part of IP address. E.g. 11

51.08 SUBNET MASK 1 [Subnet mask 1] | First part of Subnet mask. E.g. 255

51.09 SUBNET MASK 2 [Subnet mask 2] | Second part of Subnet mask. E.g. 255

51.10 SUBNET MASK 3 [Subnet mask 3] | Third part of Subnet mask. E.g. 255

51.11 SUBNET MASK 4 [Subnet mask 4] | Fourth part of Subnet mask. E.g. 0

51.16 PROTOCOL 0 Selects the application protocol and communication
profile. 0 = Modbus/TCP

51.17 MODBUS TIMEOUT | 20 *) Timeout = (MODBUS/TCP Timeout value) * 100
milliseconds. *) e.g. 20 = 2 seconds

51.27 FBA PAR REFRESH 1 Validates any changed adapter module configuration
parameter setting. After refreshing, the value reverts
automatically to done.
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Parameter | Description Setting Comment
10.01 EXT 1 COMM.CW Fieldbus interface as source for start and stop
STRT/STP/DIR
11.02 EXT1/EXT2 SELECT | COMM.CW Fieldbus interface as source to switch to EXT2 control
location
11.03 EXT REF1 SELECT COMM.REF Fieldbus interface as source for speed reference
11.05 EXT REF1 [Scale max] Max speed/frequency scaling value . Must be less or equal
MAXIMUM to drive parameter max speed/frequency.
16.04 FAULT RESET SEL COMM.CW Fieldbus interface as source for fault reset
92.02 MAIN DS ACT1 102 Actual speed value taken from 01.02
92.03 MAIN DS ACT2 e.g. 105 Actual value2. E.g. torque taken from 01.05
Optional parameter settings
Parameter | Description Setting Comment
30.18 COMM FLT FUNC e.g. FAULT How the drive reacts to a fieldbus communication break.
30.19 MAIN REF DS TOUT | e.g.3.0s Time between communication break detection and the
selected action.
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Control Builder Plus for PLC and Drives

Start the “Control Builder Plus” PC tool for PLC configuration and Drive Manager handling and go through the

following steps.

Install PS553-Drives library

Note! In Control Builder Plus V2.3 and later, the ACSDrivesBase library is already installed. You can find it in the

subfolder “PS553-DRIVES” of the default library folder (see right picture below)

Note! The version of the library can differ, nevertheless the name will stay the same! Creation date and main

changes can be seen in the library manager of CODESYS only.

For older Versions of Control Builder Plus you can download the installation package in the following way from:

0 www.abb.com/PLC:

0 On right side menu under heading "Your preferences": Select "English" as language ... (country doesn’t

matter).

0 On right side menu under "More Info Links" : Click on "PS501 Updates".

0 Select "PS501-UPDA: PS553-DRIVES..." to download 1SAP191400R0002.zip file.

Install the drives library “PS553-DRIVES” with ready-made function blocks and visualization objects by unzipping to

a temporary directory and clicking on the file “setup.exe” (see left picture below).

| Address |PSS53-DRIVES)

Folders X
ED [15AF191400R0002
=] I} PS553-DRIVES
[* ) Documentation
[# |7 Examples
# |3 Library

(% [ name -

)Examples
“%0x0407.ini
“H0x0409.ini
"% 0x040a.ini
& 0x040c.ini
% 0x0804.ini
(D datai.cab
&| datal.hdr
[ data?.cab
&) 1s5etup.dl
#| layout bin
@ Readme_e.bxt
B %setup.exe

TE) setup.inx

File Edit Wiew Tools Help

Organize = Include in library +

4 Common Files
ABB
, ABB Industrial IT
. Adobe
Apple
. Autodesk Shared
a | CAA-Targets
4 | ABB_ACSDO
L. ACSON_FWART
& | ACSON V12
. CM574 PLCConf
# | Library
P5553-0RIVES
I syslibs

|. # LocalDisk () » Program Files » Common files » CAA-Targets » ABB_ACS00 »

Share with = Burn ew folder

o MName

L ACSDrivesBas=_ACSH0_V20.EDL
| | ACSDrivesComModRTU_ACS00_V20.lib
| ACSDrivesCamMadTCP_ACS00 V22 ik
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Hardware configuration
File -> New Project -> Choose “AC500 project” and name the project. Choose PLC device according to your
equipment and then “Add device”.

- —= v —— i
L] M Preject | (Thew project [FE— =]
Categaries: Ieriatms: Dirvice rame
] Fr ] IS0 PMEA_E TR
ACS00 project Empty project Sebect device
| | vensar: [cadvendores =
il ™ Werdar Versien !
o @
HEREL |
ALS00 CHETRS 2288
LS04 PSS - M 33448
ACET PSSR ETH | 2208
acsed st a88 & 2200
" LS04 PUSEAETH H 33448
ACS00 PMSTZ 1 2200
[£ project contaming ore ACEmI PLC W 1) acsoamsrsem asea 2200
LS00 PSH W 2248
Mame:  [ACS00_ABEwters MERTL Duscksbiet A1) AC500 PMSEDETH M
1) acse0 pnsso et 2200
[R50 ABE0-<s MERTU Cusiolar | Bu\ww\u-l ™ BH 1304
T Otsplay sl verwis (for axparts say}
o] enm | A devica Cancal
P

Double-click “CPU_parameters” and configure according to your application. Set for instance “Check battery” =
“Off” if your CPU does not have a battery installed.

Ble Edt pew Powct Jooh  jedow
Do B &% G MY

Devices. - 8 % B swiPFage  Jj CPU_parameters
3 ACS0IAREDrves_MBRTL st =]
= [ AcSon_phise_ETH (ACS00 PMSSHETH) U parameters Canfiguration |
B acsio

10: 0T
_ I 10 (0nbcard 10s) B

)

# Dor LD | Failsafe function
# Cheek battery.

) C01_Online_Access [COML - Dalin Acc

2 ComMz_None (COM2 - None)
= 2% Eh {Ethmmet)
=5 et (O oard Exhemet)

10 Carrinns 110 Camtinns

Right click on the onboard Ethernet and click “Add device”. Select “Modbus on TCP/IP” and click “Add device”.
182 ACS850.ACS830, ModbusTCPEnhanced PNIST3 project - Control Buikk ] ass oevee | i)

Ele Edit View Project Tools Window Help

BEEIE S REX I

Name: [Modbus_on_TCP_IP

= Appenddevice  [nsestdevice ¢ Plug device © Update device ‘

Devices. * 0 X
=5 ACs8s0_ACSES0_Modbus TCPENhanced AMES | || Device:
=[] ACS00_PMS73_ETH (AC500 PMS73-ETH) Vendor: [ <all vendors> =]
=0 acso0 Mame [ Vendor Version
ﬁ CPU_parameters (CPU parameters) = [ Miseellanzous
10_Bus (1/0-Bus) B0 1EC 60870-5-104 ABB Automation Products GmbH  2.2.0.0

[ [Modbus on ToRIP ABE Automation Froducts GmbH 2,200

&
Interfaces (Interfaces) |8 UDPinc ACILheader)  ABB AutomationProducts GmbH  2.2.0.0

= @ Communication_modules (Communication modules) [6! UDP data exchange ABB AutomationProducts GmbH  2.2.0.0
- £ [onboard_Ethernat (0nhnard Frhamett 1
IP_Settings Copy I isplay allversions (for experts anly)

L TA524_Slot1( Paste
¢ TAs24_Slot2( . u""':": ———

u mezModsus on
¢ TA524_slot3 (] Vendor: ASS Automation Products GmbH

Categories:

L TAS24_Slot4(| ¥ Delete i

Order Number:
Export mappings to CSV... Description: Modbus on TCR/IP
Import mappings from CSV...

Add Object

Add Device... Append selected device as last child of

Onboard_Ethernet

@ (¥ou can select another target node inthe navigator while this window is spen.)

Insert Device...

Update Device...

Edit Object Close

No further configurations for Modbus TCP has to be done.
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IP configuration of CPU (for Ethernet connection between PC and PLC)
If the IP address has not already been configured, follow the steps below.

De-activate the firewall of the PC, or allow the connection if question comes up. Connect an Ethernet cable
between PC and PLC (or via a switch).

Open the IP configuration tool from the “Tools” menu and press the “Scan” button.

Start Page IP-Configuration

A ABEDri
File Edit View Project | Tools | Window Help
= = = | IP-Configuration z
can
Devices MultionlineChange

=3 ACSI0_ABBDrives_ME Drive Overview
=-fffl acsoo_pmssa_ETy @ Package Marager... .
&l acsoo MAC address | Index | Device name |

ﬁ CPU_paramet m Device Repository. ..
= t[w] oBIO(Onbe Options...

Select actual PLC from the scanned objects (1), make your network settings (2) and press the “Send Configuration”
button. This needs to be done the first time you connect to the PLC even if the IP address is already correct.

Note! The PLC needs to be in “STOP” mode for IP configuration.

After the new configuration was sent the PLC will automatically reboot.

Start Page .~ IP-Configuration

Scan

I -
DEvice I | COrrent 1P aodress |I comfigerediR address | Auth. supp |
0x00 192.168.0.10 192.168.0.10 no

eral number
0000000859

PM554-T-ETH

|Scan abborted, found 1 response

PM554-T-ETH [SN=0000000859, ID=0x00]

New configuration

[ DHCp r

IP address

Subnet mas

send Configuration

Standard gate: N ——

Link mode |Autn j
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CODESYS
Double-click “AC500” from the Device tree in the Control Builder Plus project to open CODESYS.

I 500 Asa0rves WERTU QUERARRERREE G

Fle Edit Vew Project Tools Window Help

S = & B X O

Devices + o X
=l AC500_ABBDrives MBRTLL Qudistart =
=-(fl) Acsnn_PMS54_ETH (ACS00 PMSS4-ETH)
E1 [acson
CODESYS tabs

In CODESYS there are four different tabs for programming, configuration, etc.

POUs (Program Organization Units): This tab contains your Functions, Function blocks and Programs.
Data types: In this tab, along with the standard data types you can define your own user-specific data
types.

3. Visualizations: In this tab you can create your own or use predefined visualizations to display your project
variables graphically. In Online mode, these can then change their form, color, text, position, output, etc.
in response to specified variable values.

4. Resources: In this tab you can configure and organize your project. It includes Global variables, Library
manager, etc.

@y CaDeSys - ACS00.ACS00PRO

File Edit Project Insert Extras Online Window Help

H| 5|85 |2

| PDUSI.I: Drata typesl\f\sualizationsl% Fezources
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Library Manager

Open the Library Manager by double-clicking “Library Manager” from the “Resources” tab. Right-click in the

library field and choose “Additional Library” (or select “Insert” form the menu).

®y CoDeSys - ACS00.ACS00PRO - [Library Manager] -— O | E |
(i) File Edit Project Inset Extras Online Window Help S
El LS %I@ * El%l%l-’d
standard 1ib 4 10 05 11.14 46
%2, Resources ~]| |Iecsfc.lib 13.4.06 15:51:28
-1 Global Variables Util lib 18.5.10 15:14:28
- ] SysLibTine.lib 26 3.12 1606 01

B0 fibrary Ethermet_ACS00_%10.b 26.2.12 16:06:29: ¢ SysTaskInfo.lib 26.3.12 16:06:01

B[ hbvary lecsfc b 13.4.06 15:51:28: global variables SyslibMen. lib 26.3.12 16:06:01

B[] libeary MODBUS_ACE00_v10.5ib 26.3.12 16:08:2%: EYEHBCALEEQSE ﬁg i6h32é23lizﬂisﬂés 59

B | thernet_ _ i

i CII!blaryDnanrdID_ACSUD_WS.hb253121505&E EusDing Tib 267312 16:06.01 I

B0 ibrary Sysint_ACS00_Y10.1b 5 4.12 08 4524 glob Cyelnt ACEO0 W10 1ib 5.4.12 05:45. 24

B[ library SysLibé BB Cla b 26.2.12 16:08:27: glabal v Sy=Ext_ACS00_V10 1ib 26.3 12 16:06:01

B[] ibrary SysLibMem.ib 26.3.12 16,06 01: glabal varia ﬁgggggdiggggsgga"ﬁﬁl;g gﬁig igéggg 02

B0 ibrary SysLibTimeib 26.3.12 16:05.01: global varia MODBTIS_EXT_ACS00_¥20 1ib 26 3. 12 16-08-29

Bl library SysTaskinfo.ib 26.3.12 16:06:01; global varl || |SysLibABBCEg. 1ik 26.3.12 16:06:27

B (20 fbrary Ui 18510 15:14:28 global varisbles e —
Bl (3 Tools Additional Library ... Ins

#laim configuriation Delete Del

. m & Properties ... Alt+Enter

B Log - E = -
q ‘% s PDUSI'G Data lypes]\fisuahzationsl. G\oba\\v’aliablasl

FOUs| ™ Diata types| ] Visualzatio. .| $24 Rresources| - - — — :
|Adds another library to the project OMLINE ’W READ

Select the “ACSDrivesBase_AC500_V20.lib” and “ACSDrivesComModTCP_AC500_V22.lib” library files from the
PS553-DRIVES folder (under the standard CODESYS library folder) and click “Open”. The libraries are added to the
project.

Note! When copying projects the used libraries must be found on the same library path as on the original PC.
Otherwise a warning will show that a library can not be found. If so, this red marked library has to be deleted and
added newly from the now different path to the project before saving the project.

By CoDeSys - ACS00.ACS00PRO” - [Li

mEiIe Edit Project Insert Extras Online Window Help
B DR e & (mem6edE|

B —DRIY ‘ nHodT
% Resources PSEEI-DRIVESNACSDrivesBase ACRO0_VI
(] Global Variables

SysLlibs~SysLibABBCig. lib 26.3.12 21

wor . ==

< | m

Look in: ‘ PS553-DRIVES j & eF B~ t-(Z library SsT askinfo lib 26.3.12
. - o e 1490

Mame Date modified T : (22 brary UtiLlb 18.5.10 15:14:28;

% | ACSDrivesBase ACS00_V20.lib 1/16/20132:59 PM LI Tools o

%] ACSDrivesComModRTU_AC500_V20.lib 1/16/2013 256 PM LT ' Alarm configuration

% ACSDrivesComModTCP_AC500_V22.lib 12/14/20121:57 PM LT Library Manager

File name: ["ACSDrivesBase_AC500_V20.ib" "ACSDrivesC Open

Files of type: [ CoDeSys Library (*lib)

j Cancel

Library directary: [

=]

Modbus TCP

£

B2 library Ethemet_4C500_%10.H
B2 library lecsfe b 13.4.06 15:51:
Bl (2 library MODBUS_ACS00 V10,
B[] library PSE53-DRIVE S44C5Dn
B2 library PS553-DRIVE S%ACS D
B[] library Spslnt_ACH00_%10.5ib 5
E-] library SysLibbdem.lib 26.3.12 2
B[] library SysLibs\SysLibABECHg.|
B2 library SesLibTime.lib 26.3.12 2
£
[
E

3 m Log

FLC - Browser

- ({# PLC Configuration

@ Sampling Trace

ﬁ Target Settings

- (388 Task configuration

Q ‘watch- and Recipe Manager
'}Q Workspace

-25-

MODEUS _E=xt_ACS00_WV20.1ib 26.3.12 21
HODEUS_ACE00_W¥W10.1ib 26.3.12 20:36;
Ethernet_ACE00_W10.lib 26.3.12 20:3
BusDiag.lib 26.3.12 20:36:01
SysInt_ACS00_V10.1lib 5.4.12 13:15:32
SysExt_ACS00_V10.1ib 26.3.12 20:36;
standard.lib 4.10.05 11:14:46
Iecsfc.lib 13.4.06 15:51:28
Ttil.lib 18.5.10 15:14:28
Sy=LibTime.lib 26.3.12 20:36:01
Sy=Ta=skInfo.lib 26.3.12 20:36:01
SyslibMen.lib 26.3.12 20:36:01
SYSLIBCALLBACK . LIB 26.3.12 20:36:01

1 | [} 3

=4 POUs
B-423 Modbus TCP
B-{Z3 ACS Drives
ACS_COM_MOD_TCP [FE)

: OM_MOD_TCP_EWHANCED
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PLC logic

The following program communicates with ACS 850 drive over ModbusTCP, using the ABB Drives enhanced
profile.

Compile your project, choose “Rebuild all” from the “Project” menu.

®y CoDeSys - AC500.AC500PRO* - [Library Manager]

m[l File Edit [Eroject] Insert Extras QOnline Window Help
EI [E7] Build F11
Rebuild all o]
S POUs Clean all
REEES Load download information...
Object 3
Project database 3
"5 Pous™= Options...

Right-click “PLC_PRG” in the “POUs” tab and choose “Convert Object”. Choose Target Language “FBD” and click
”OK”.

By CoDeSys - ACS00.ACS00PRO* - [Library Manager]

) File Edit Project Insert Exdtras Online Window Help

FEEEEE

===

Convert Object

=

a9 EWl [Feeding Tibeazy ‘G- Progeam Files~Common Eiles CAA-TargsteAEE_AC Converting POL: FLC_FRG
Add Object... Mew POU name: PLC_PRG Canel
Rename Object...
Edit Object Target Language:
"8 Pou™E vate. Y Syl D L * FBD LD
| =——————=—" Delete Objest I
Conwerts the selected object inl Convert Object... OHLINE [0V [READ
Lonvers the selecled et L

Right-click in the POUs field and choose “Add Object”. Set Type of POU to “Program” and Language of the POU to
“FBD”, give the new Program a suitable name and click “OK”.

5 CaoDeSys - AC500.ACS00PR

Fie Edit Project Insett Etros Oniine Window Help

B DEEEE $E %[

Mame of the new PO

]

Ok,

Type of FOU Language of the FOU Cancel
% Progiam L
a POUs " Function Block 0]
" : « Function o RD
Add ObJ ect... Retum Type: © s
Rename Object... Ll || e
i ] " CFC
Edit Object
Copy Object
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Double-click “PLC_PRG” (1) to open the main program. Select the dotted box (2) in Network 0001 and insert a box
(3). Write the name of your new Program (ACS850 (PRG) in the example) to call for it from the main program.

4 CoDeSys - AC500.AC500PRO" - [PLC_PRG (PRG-FBD)] ¥ ]
DOOL PR PLC

ﬁFiIe Edit Project Insert Extras ©Onlne Window Help

=) R e e e e T e e e
PROGRAM PLC_PRG e

var 3
END_VAR

ACEERD

Double-click your new program (1) and add a box as described above. This time, press F2 while the block title is
selected and choose “ACS_COM_MOD_TCP_ENHANCED” (2) from “Standard Function Blocks”, then click “OK”
(Tip: untick the “Structured” box in the Input assistant (3)).

ﬁFl\e Edit  Project Insert Extras Onlne Window Help

- B BSSEAR &= b= L e R i v =2 e s s

000M|PROGRAM ACS850
0002)AR
0003 END_vAR

Input assistant

Standard Functions 5—COM_MOD_TCH

<1 (| Uszer defined Functions MOD TCP ENHANCED
a — Standard Functior A FHYESCFRL_ENG Cancel
oot User defined Function Blocks ACS_DRIVES_CTRL_STANDARD 4
FBD Operators A0S DRIVES_CTRL_STAMDARD_GEN
Standard Programs ACS_MOD_READ_MN_PRM
a9 Uszer defined Programs ACS_MOD_WRITE_N_PRM =
e Conwersion Operators ACS_REF_SCALING
s AC5 3=+ _DRIVES_CTRL_BASIC
BLINE
CHARCURVE
CLOCK
CLOCE_DT

COM_MOD_MAST

COM_MOD_5LY_SET_ADDR

CPU COMFIG_FEAD

CPU_COMFIG_WRITE

CPUPROD_ENTRY_READ
il

CTuD
CurTime
CurTimeE »

VE

<

3 ™ Stuctured

Give the instance of the drive communication block a suitable name (1) and declare it as of type
“ACS_COM_MOD_TCP_ENHANCED” (2) (automatic suggestion).

8| OSSR k| 2 &E@FE [0: -] ]| 5]

| [O0D1[FROGRAM AGEESN
SR D00Z/VAR
] OOD3[END_ VAR

] PLC_PRG [PRG)

L <
el 1 <Enter>

fa__c_o—m')—b Declare Variable

ACS_COM_MOD_TCF_ENHANCED Mame e 2
TREEN Dohe— ] ACS_COM_MOD_TCP_E
777-[5LOT ERR|— et b =
P?P7ELAVE_IP ERMO— Symbol list Initial Walue Address
797 -|DRIVE_TYPE BugY— Glohal Wariahi: =
777 |HvAR_READ CMLINE— = I [ CONSTANT
777 {NVAR_WRITE READ_VALUES— Comment: ™ RETAIN
797 WRITE_VALUES I~ PERSISTENT
777 -|DRIVE_DATA »
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Open the program again from the “POUs” tab and connect the function block inputs and outputs according to
your needs. In the example below, the block will always be enabled. Slot 0 of the PLC is used, the drive has IP
Address 192.168.0.11, drive type is ACS850, no extra parameters besides Status word and Actual speed/torque are
read from the drive.

Tip! Click inside the name of the function block and press F1 to open the description of the block in the online help

Create a second network (Ctrl +T) in the same program and add the block “ACS_DRIVES_CTRL_STANDARD” in the
same way as for “ACS_COM_MOD_TCP_ENHANCED”. Connect the function block inputs and outputs according to
your needs. In the example below:

e The block will be enabled once the communication block is online.

e Other than Enable input the complete block will be controlled by using the Visualization.

e The variable connected to “ACS_DRIVES_CTRL_STANDARD” -> “DRIVE_DATA” must be the same as the
one connected to “ACS_COM_MOD_TCP_ENHANCED” -> “DRIVE_DATA” and must be of type
“ACS_DRIVE_DATA_TYPE”.

J < CoDeSys - AC500.AC500PRO* - [ACSB50 (PRG-FBD)]

®y Fic Edi Project Insert Extras Onlne ‘indow Help

B B|E]eeaE i [RlRml [0r < |l 5
g (oo

01[FROGRAM AGSES0
= POUs [oonalvar
i) (0003  FE_COM: AGS_COM_MOD_TGR_ENHANGED;
“-lf| PLC_PRG [PRG) [0008  FB_CTRL: ACS_DRIVES_CTRL_STAMDARD;
0008  DriveData: ACS_DRIVE_DATA_TYPE;
(0006  xOnline: BOOL,
DO0F|EMD_WAR
Fererees|
[ <
0001
FB_COM
ACE_COM_MOD_TGP_ENHANGED
TRUEHEN DONE——
o-sLoT ERR|—
182.168.0.11'{SLAVE_IP ERNO[—
4CS_DRIVE_ACS850-{DRIVE_TYPE BUSY—
NVAR_READ ONLINE[—xOnling
NYAR_WRITE READ_WALUES|—
—WRITE_VALUES
DriveData—{DRIVE_DATA =
000z
FB_CTRL
ACE_DRIES_CTRL_STANDARD
x0nline—EN DONE— ¢
—START ERRI—
—STOP_EMCY_COAST ERNO—
—STOP_EMCY_RAMP READY|—
—STOP_COAST OPERATING|—
—RESET TRIPPED|—
—EXT_CTRL_LOC ALARM—
—SPEED_REF EXT_RUN_EMABLE[—
—REF_VALUEZ LOGAL_CTRL—
DriveData{DRIVE_DATA & EXT_CTRL_LOC_ACT—
ACT_SPEED|—
ACT_YALUEZ—
ACT_SWi—
1 USED_Cli—

The variables declared between “VAR” and “END_VAR” in the picture below are local variables from the actual
program (PRG). To access them form another program or a visualization the program name has to be used
followed by a dot and the variable name. E.g. “ACS850.DriveData”.
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Download program to PLC

Save the program (1) and choose “Communication Parameters” (2) from the “Online” menu. Set communication
Parameters according to your online connection (3) and close the dialog with “OK” (4) In the example below, the
“Address” 192.168.0.10 corresponds to the IP address of actual CPU and is also the default IP address of AC500
CPUs. Note that in case of Ethernet connection, the IP address of your PC port or Ethernet adapter should belong
to the same subnet as the CPU, 192.168.0.XXX (XXX between 1 and 255).

4 CoDeSys - AC500. AC500PRO™ - [ACSB50 (PRG-FBD)]

QFi\e Edit  Project Insert Extras Nellly® Window Help

(B Elsledais(Eg & o5 e
Mt 000
(3 FOUs Moo
<0 00 i 6
“glf] PLC_PRG [PRG) 000
ooo
000
ooo
fono
— Communication Parameters
nnot
Charinels
|
ACH00 Default TCPAP|
‘ “alug | Comment | ﬂ
1582168.0.70  IP address or hastname
120 3
Motarala bytearder Yes New
Remove
———  Simulation Mode 2 — Gateway =
8|  Communication Parameters. ..
Send marked text ko RemoteCantrol Master (&.0. as parametsr) k Update
reate book, project
Show Fil infarmation
| ﬂ TOF_COAST OFEFR. IIN(J'—

Choose “Login” (5) from the “Online” menu and in the following pop-up window, click “Yes”. Then choose
“Run” (6) from the “Online” menu to start the PLC. Check that the PLC goes to “RUN” mode in the PLC display, led
or status bar of the CODESYS window.

|ONLINE: AC500 Default TCPAP [SIT]_[RUNNING_JBF [FORCE [0 [FEAD

Note! If the PLC does not go to “RUN” mode, you might have some PLC errors that you need to reset. You can do
that either by pressing the “DIAG” button on the PLC itself (not in the AC500-eCo series) followed by the “OK”
button until all errors are reset. You can also do it in online mode by using the “diagreset” command from the
“PLC Browser” in the CODESYS “Resources” tab.
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Create boot project

In “online” mode (Login), choose “Create boot project” from the “Online” menu. With this command, the
compiled project is stored to the flash in such a way that the PLC will load it automatically when restarted.

4 CoDeSys - AC500.AC500PRO* - [ACS850 (PRG-FBD)]
®y File Edit Project Insert Extras Roli window Help

B 28edaS

Logaut Ctrl+F3
[ Pous

-] PLC_PRG [PRG] Stop Shift-+Fa
Reset
Reset {cold)
Reset {original)
Toggle Breakpoint F3
Breakpoint Dialog
Single Cycle Chrl+F5
witike Values Ctrl+F7
Force Values F7
Release Force shift+F7
‘Write /Force-Dialog Chrl+Shift+F7

Show Call Stack...
Display Flow Control

Send marked text ko RemoteControl Master {e.q. as parameter)

Read file from PLC

Visualizations

Visualizations are optional and can be a good way to test the communication between PLC and drive. Go offline
(“Logout” from the “Online” menu). Right-click “Visualizations” in the “Visualizations” tab (1) and choose “Add

Object” (2), give the visualization page a suitable name (3).

From the new page, choose “Visualization” from the

“Insert” menu (4) and draw a box. Select Visualization “ACS_COM_MOD_TCP_ENHANCED_VISU_PH” (5).

< CoDeSys - AC500.AC500PRO™ - [Visu_ACSS!

Fi|E Edit Project Insert Extras Online Windo
N R A

Add Object...

Caopy Object

- CoDeSys - ACS00.ACS00PRO™ - [Visu_Al
File Edit Project

H| E|@]eeE

7 a Yizualizations

Extras Crline W

Inserk

New Visualization
v Rectangle

Rounded Rectangle
Ellipse

Mame of the new Yisualization:

isu_ACS 850
3

Tlew Foder P D|‘>-'l;|0n
Callapse Node Palyline
Curve

1
e

POLSJ 22 Dot i 5] visueatons| 325 esor
T e

Srvmllbze
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Select Visualization

Wi

COM_MOD_TCP ENHZ
0. ICP
ACS_Cw_VISU_PH
ACS_DRIVES_CTRL_ENG MSU_PH
ACS_DRIVES_CTRL_STANDARD_GEN_VISU_FH
ACS_DRIVES_CTRL_STANDARD_VISL_PH
ACS_MOD_READ_N_PRM_VISLI_PH
ACS_MOD_WRITE_N_PRM_vISO_PH
ACS_REF_SCALING_WISU_PH
ACS_SW VISU_FH
AC5344 DRIVES_CTRL_BASIC_VISU_PH
visuDME_I0_CNT

Cancel
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Double-click the new visualization object for Settings and click “Placeholder” (1). Select the “Replacement” field
(2) and press F2.

To make a connection to the instance of the function block “ACS_COM_MOD_TCP_ENHANCED"”, choose the
instance from actual program (PRG) (3) and click “OK” until all pop-up windows are closed.

Tip: Tick the “Structured” box in the Input assistant window for a better overview.

0 TCP EMHANCED B e e e e e e e

E L T

" “#““— & “+—“H W " /"""~ """¥V0909 7 1»m - - - -:-ccc0c0000000o0005000000000000600000a0o0

B Categary: .

o e

Text Visualization: _[ACS_COM_MOD_TCP_ENH . | L:::::::::::::::::::::::::::::::::::::::::

L TEHt Variables .........................................

7 | Colorvariables Placeholder... 1 Fancel || oo

Ling width s S

Y Mation absolute o e

Mution relative e . . . L

M |Variables L~ |

| Input R P

B | o frtokip Placehoider | Reglacemort —— oK N

O | Programmability FE I

O 2 .

[n) P .

. F2 :

5 =3 Watch Expressions 0K | .

i B[] AC5850 PRG) :

- carcel |1

o B B3 DriveData [A R ﬂ :

E K 1cSai FE_COM [ T :

DATA_IN11 - Al
DAT_IN1Z B g wlnline (BOOL)

B (fff) C:\PROGRAM FILESN\COMMON FILESACAS-TARGETSYABE_ACSOMNACSD0
A B ) C:\PROGRAM FILES\COMMON FILES\CAS TARGE TSAABB_ACSINNACS00
............... E-(ffff CAPROGRAM FILES\COMMON FILES\CAA TARGE TSVABE_ACS0MACSO0
T B (i) C\PROGRAM FILES\COMMON FILESACAA- TARGE TS\ABE_ACSINNACS00
[ .. B (ffff C\PROGRAM FILES\COMMON FILES\CA4 TARGETSYABE_ACS00NACSO0
o b h s conacennanannnnannnnanao < Ed

On the same page, create a visualization element for the drive control. Insert -> Visualization -> Select
“ACS_DRIVES_CTRL_STANDARD_VISU_PH” -> double-click the new object and click “Placeholder” -> Press F2 from
the “Replacement” field -> Choose the instance of function block “ACS_DRIVES_CTRL_STANDARD” -> click “OK”
until all pop-up windows are closed.

Go online again by choosing “Login” from the “Online” menu and then “Run” from the same menu (if the PLC is
not already in run mode).

The status of the function block inputs and outputs are now displayed in the visualization window.
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Note! Only Block inputs which have not been connected to the function blocks in the program “PRG” can be
changed from the visualization window.

Some examples of what can be seen in the visualization:

e READY: if the drive is ready to start.

e OPERATING: if the drive is operating (magnetizing the motor), if remote control form PLC is active..

e TRIPPED: if the drive has an active fault.

e ACT_SPEED: actual speed value.

e ACT_SW: actual 16-bit Status Word from the drive.

e USED_CW: actual 16-bit Control Word sent from the PLC to the drive.

e MESSAGE field: information about the actual state, e.g. “Operation” or “Wait for rising edge of START".

EM

sSLoT
|P-ADDRESS
DRME_TYPE
MNAWLR_RESD
MNWLR_WRITE

EN

EMCY _COAST
EMCY _RAMP
STOP _COAST

La=stwriteErr
ReadErrCrit
LastRead Br

LOCAL CTRL
EXT_CTRL_LOC EXT_CTRL_LOC
SPEED REF

REF AL UEZ

M G
Refid ue 1

Refvd ue2

DATA_OUTA
DATS_0UTZ
DATS_0UTS
DATA_OUT4
DATS_0UTS
DATS_OUTE
DATA_OUTY
DATA_OUTS
DATA_OUTH
DATA_OUTIO
DATA_OUTI1
DATA_OUTIZ

S

=
-
=]

eSS AE

o|lo|le|le|le|m|m| ==
o|lo|le|le|le|m|m| ==

Go offline by choosing “Logout” from the “Online” menu.

Further Information about the visualization elements can be found in the Help. Search for e.g.
“ACS_COM_MOD_TCP_ENHANCED_VISU_PH”
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Test the program via the visualization
If the drive has an active fault (“TRIPPED” output is colored orange), then try to reset by clicking on the “RESET”
input = TRUE (1).

When the “READY” output is TRUE (green), then set the “SPEED_REF” input (2) to desired speed value and
“START” input = TRUE (3).

Note! Speed reference is set in the block input “SPEED_REF” as a value between -20000 and 20000, where 20000
corresponds to a parameter in the drive reflecting the maximum speed of the drive (see chapter “Drive
configuration”).

ACS DRIWES CTRL STANDARD

0O OME

FALSE  [BTART ERR
EMCY_COAST ERMO
EMCY _RAMP READY
STOP _COAST OFPERATING

LOCAL CTRL
EXT_CTRL_LOC
ACT_SPEED

MESSAGE TRIFFEL - Reset drive

This action can of course also be set by real variables directly connected to the corresponding inputs in the
program.
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Read and write more data between PLC and drive (optional)

While the already implemented function block “ACS_COM_MOD_TCP_ENHANCED” has built-in functionality to
read more data/parameters which must be configured in the drive at “FBA Data IN” and “FBA Data Out” groups,
the function blocks “ACS_MOD_READ N_PRM” and “ACS_MOD_WRITE_N_PRM"” can read and write
data/parameters from the drive according to user choice in the AC500 program.

Example - Read drive data with “ACS_COM_MOD_TCP_ENHANCED”

Values are read from “FBA Data IN” group in drive. The number of read parameters depends on the function block
input “NVAR_READ”. Configuration is made in parameter group “FBA Data IN” in the drive. The supported number
of parameters that can be read in this way depend on actual drive type, for instance 10 parameters can be read
from ACS355 or 12 parameters can be read from ACS850, ACSM1 or ACS880.

Additional parameter settings in the drive are necessary, see example below with an ACS850 drive:

e 52.01=117 -> actual value 01.17 Motor Temperature will be written to READ_VALUES[1]
e 52.02 =801 -> actual value 08.01 Actual Fault will be written to READ_VALUES[2]
e 52.03=1901 -> parameter 19.01 Speed Scaling will be written to READ_VALUES[3]

@
Mame | Yalue | Linil

51 FBA settings
[l 52 FBA datain

1 FBA dataint 117
2 FBA data in2 201
3 FBA datain3 1901
4 FBA data ind 0

Note! After these changes of fieldbus parameter settings, the parameter 51.27 has to be set to 1 (Refresh) to
activate the new settings (the fieldbus coupler FENA-11 will restart).
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Set “ACS_COM_MOD_TCP_ENHANCED"” block input “NVAR_READ” according to number of parameters to be read
(1). Create a new variable connected to block output “READ_VALUES” (2), press <Enter> and the “...” button (3) to
set the variable of type “ARRAY” (4). Give the array Start index 1 and End index 12 (5), set the type to INT (6)(7)
and press OK.

0001
FE_COM
ACS_COM_MOD_TCP_ENHANCED
TRUE-EN DONE
o-sLoT ERR|—
'192.168.0.11'SLAVE_IP ERNO|—
ACE_DRIVE_ACS: RIVE_TPE BUSY|—
1 R_READ ONLINE—«0nline
AR _IRITE READ_WALUES <Enter>
iR TE_WALUES
DriveData-|DRIVE_DATA = .
Declare Variable r5_<|
000z
............ FB_CTRL LClass ﬂ.ame
ACS_DRIVES_CTRL_STANDARD |VAH ﬂ |‘3'F"3‘3‘:|\"1‘3|“ES pa—
xOnline-EN PONEF= 1 Symbol st Initial Yalue Address w
HSTART ERRf— 3
STOF_EMCY_COAST ERNOf— | J | Array Boundaries r5_<|
—STOF_EMCY_RAMF READY|— —
HSTOP_COAST OPERATING— Comment: D o
—RESET TRIPPED|— i I—I EMT
HEXT_CTRL_LOC ALARME— 2 5 Cae]
—SPEED_REF EXT_RUN_ENABLE|— 3 |
—REF_WALUEZ LOCAL_CTRL—
DriveData—DRIVE_DATA & EXT_CTRL_LOC_ACT|— 4 |2
ACT_SPEED|—
ACT_WALUEZ|— ! 6
ACT_swil— Typel |IMT

The parameter values from the drive are then written to the new array variable (8). Check this in online mode.

----- DriveData
x0nline = [E0IE
Eif-aiReadvalues Q
--giReadvalues[1]= 227
--giReadvalues(Z] =10
~-giReadyalues[3d] = 1500
S CELPEEE R
--giReadvalues[a] =10
~giReadvalues[f] =0
FB_CON
ACS_COM_MOD_TCP_EHMHAHCED
TRUE-{EN DONE
0-4sLoT ERR|—
92 4GS 011 4 SLAVE_IP ERNO|—
ACS_DRIVE_ACS250{DRIME_TYPE BUSY—
Z{HWAR_READ OHLINE—Online
—HVAR_WRITE READ_WALUES—aiReadialues
—WRITE_VALUES
DrivelrataqDRIVE_DATA
FB_CTRL
ACS_DRIWVES_CTRL_STANDARD
=0nline—EH LOME
—START ERR|—
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Example - Read drive data with “ACS_MOD_READ_N_PRM”
Values are read from any Modbus register address in the drive according to user choice. No additional parameter

settings in the drive are necessary.

Create a new network in the same program (POU) and add the block “ACS_MOD_READ_N_PRM".

ACT_VALUEZ
Ml Declare Variable § .

¥7pRID ERF
e MR ERHO J | J | [~ COMSTANT
77| PRA_NUM BUSY

TP DATA Comment:
TP ORIVE_DATA -

Clazs Mame Type -m .

FB_READ_PARAMETERS AR - |FB_F| EAD_PARAMETERS |AES_MDD_F| EaD_M_PR J :

ACS_MOD_READ_M_FRM Cancel .
DOME] Symbal lizt Initial % alue Address

[~ RETAIN

I~ PERSISTENT| -

Set function block inputs according to:

e EN =xEnRead, which is a new variable (1) -> The block will be enabled if xEnRead is set to TRUE

e PRIO = Left unconnected.

e NVAR = Number of parameters to be read (2) -> 8. In this example 4 parameters of 32bit will be read, this
means 8 words have to be configured.

e PRM_NUM = Start address of parameters to be read (3) -> parameters 22.02 to 22.05 (Acceleration and
Decceleration times) will be read in this example. Because these parameters are 32bit parameters the
conversion function “ACS_MOD_PRM_NUM_32Bit” (4) has to be used.

If normal 16bit parameters are addressed this function must not be used.

e DATA is connected via an “ADR” block to a new array variable (5). Press the “...” button (6) and choose
type “ARRAY” (7), set Start index to 1 and End index to the number of values to be read, 8 in this example
(8). Set type to “WORD” (9), (because for 32bit values you have to consider the High and Low Word) and
press “OK”.

e DRIVE_DATA =the same variable that is connected to “ACS_COM_MOD_TCP_ENHANCED”->
“DRIVE_DATA” (10).

0003 4
e 1 FB_READ_FPARAMETERS

T ACS_MOD_PRM_NUM_3ZBIT ¥ ACS_MOD_READ_N_PRM
zznz}PRM_NUM £ «EnReadEN_Y DONER—

[ —
JFRID D ERR|—
ADR @NVAR ERNO—

aifcchecTimes PRM_HUM BUSY —
10 ; DriveData—|DRIVE_DATA b o
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LClass Mame

]VAH j ]a\Achachmas

Sumbal list Lnitial % alue it
[Fisbel Varables =] | =]

Camment:

£ B2
9
Typd: [woRD] |

Go online and double-click to the input variable xEnRead. A TRUE is shown besides (1) . Write this value to the
variable by “Online” -> “Write Values” (2) or pressing <CTRL + F7>,
Then the input is set to TRUE (3) and the parameters are continuously read from the drive until you reset the input

variable in the same way.
Rl Window  Help

! Logast LY
1 op St
- FE_READ_
1 FB_READ_PAR —. . ACS_MOD,
ACS_MOD_REZ et «EnRead—EN
#*EnRead TRUE—HEN ;
e - FRIO

FRIO W o

Now you can click on the “+” of the “awAccDecTime” array (1) in the variable declaration area to see all array
values.

The parameter 22.02 is split into Low and High Word. The Low Word is put to array index [1] while the High Word
is available in the array index [2] (2). (As the High Word is zero there is actually no need to consider the High
Word.) A screenshot of a connected Drive Studio tool shows the values in the drive besides (3).

AccDecTimes 2 Malloc.in
wetccDecTimes[1] 5000~ Loy Word __va“_‘l__e"' b El 22 Speed ref ramp
waceDecTimes[2] 0 —High YWord DrveEStudit)| i1 accpec zel  False
wACEDecTimes[3] 5000 3 At timel e :
whACcDecTimes[4] O : -
whctDecTimes[s] BO000 3 Dectimel 5000 s
wACcDecTimes[g] O -4 Acc timez 60,000 5
waccDecTimes([7] B0000 £ Dec b2 connn s
egwhccDecTimes[8] 0 5 Shape time accl 0.100 .

ACT _WALUEZ —
ACT_Swi—
USED_Cuif—
FB_READ_FARAMETERS
ACE_MOD_FRM_NUM_3ZRIT ACS_MOD_READ_N_FRM
ZZDZJPRM_NUM =EnRead—4EN LONE
—FRIO ERRF—
ADR 2 HWAR ERNO—
anfcchecTimes PRI_HUM BUSY—
DATA
CrivelataqDRIVE_DATA -

Note! Several “ACS_MOD_READ_N_PRM” blocks can be activated at the same time.
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Example - Write drive data with “ACS_MOD_WRITE_N_PRM”

Values are written to any Modbus register addresses of the drive according to user choice. No additional
parameter settings in the drive are necessary.

Create a new network in the same program (POU) and add the block “ACS_MOD_WRITE_N_PRM”.

FB_lrite_PARAMETERS
: [ ACS_MOD_PRM_NUM_Z2RIT [ ACS_MOD_MRITE_N_FRM
§|2203—IPRru1_NLlru1 L B cute'l.lll'rite—IEN DONE[—

=1:1:11n] ERFRf—

ADR Z—IN"-.-"F'.R ERMNOf—
au‘n.l'u'l.l'riteAchecTirnesi —| FRI_MNUM BUSY|—
CaTA

Crivelata{iRIWVE_DATA =

Set function block inputs according to:

e ENis connected to a new variable “xExcecuteWrite” of type “BOOL” (1). At rising edge the values are
written once.

e PRIO = Left unconnected.

e NVAR = Number of parameters to write (2) -> 2. Low and High Word of an 32bit parameter will be written
in this example.

e PRM_NUM = Start address of parameter to be written (3) -> parameter 22.03 (Dec time1l) will be written
in this example. As parameter 22.03 is a 32bit parameter the Function “ACS_MOD_PRM_NUM_32BIT” (4)
has to be used before the input PRM_NUM of the Function block.

If a normal 16bit parameter shall be written this function must not be used.

e DATA is connected via an “ADR” block to a new variable (5) of type “ARRAY [1..X] OF WORD” according to
instructions for the “ACS_MOD_READ_N_PRM” block in the previous chapter.

e DRIVE_DATA = The same variable that is connected to “ACS_COM_MOD_TCP_ENHANCED” ->
“DRIVE_DATA” (6).

To write the parameter the the following steps have to be performed:

Open the awWriteAccDecTimes array in the variable declaration part (1)

Double-click to the Low Word index of the array (2) and fill in a new value for the parameter (3)
Double-click on the variable xExcecuteWrite to preset to TRUE. (4) and Press <CTRL + F7> (5) or “Online” ->
“Write Values” to set the new values.

The new values are written to the variables, the write job is performed at the rising edge of the EN input.(6)
In the awAccDecTimes array the new value can be observed (7).
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0027

002§

0029

0030

0031

0032

0033

0034

0035

0036

0037

0038

0039

004

o041|

0042

0043

0044

0045

0046

0047

--F B _Write_PAl

~agwitiiteAccDecTimes[1] .0

FB_READ_PARAMETERS
¥EnRead =
awAccDecTimes
--gwAccDecTimes[1]= 5000
wetccDecTimes[2] =0
waccDecTimes[3] = 5000
weccDecTimes[d] =0
waccDecTimes[s] = 60000
weccDecTimes[B] =0
--gwAccDecTimes[7] = 60000
~gmiccDecTimes[8] =0

5: <Enter +F7>

myy Y

4
4 =TRLUE=

X

Write Variable *awWriteAccDec Times[ 1]
=a8T700=

0ld Value: |0

e alue: |E?EID

- guriteoc DecTimes[s] = 0 3
gwiiiTiteAccDecTimes(8] = 0

Cancel

~guwhriteAccDecTimes[2] =0
~-guliiriteAccDecTimes[3] =0
whtriteAccDecTimes[4] =0

28 sEnRead=

28 B--aweaccDecTimes

30 wetccDecTimes[1] = 5000
21] wAccDecTimes[2]=0

33 wetceDecTimes[3] = 8700
23 wAccDecTimes[4] =0

34 wetceDecTimes[5] = 60000
25| wAccDecTimes[E] =0

36 awiccDecTimes[7] = 60000
37| ~gwiccDecTimes[8] =0

=8| @ filrita—P AR =

39| cuteifrite = 6
40 Ea TaTRR A ace

41 whtriteAccDecTimes[1]= 8700
42 awtriteAccDecTimes[2]= 0
43 FegdriteAccDecTimes[3] = 0

~-gulriteAccDecTimes[f] =0

Note! Several “ACS_MOD_WRITE_N_PRM” blocks can be used in the program. The variable is only written at a
rising edge of the EN input.
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Add more drives (optional)

In the CODESYS “POUs” tab, right-click the program for your earlier drive and choose “Copy Object”, give the new
program a suitable name and double-click “PLC_PRG”. Add the new program to the main program by copying
Network 0001 to Network 0002 and rename the block in Network 0002 according to your new program.

@y Fle Edt Froject Insert Extras Onlne Window Help

EE e e E

000[FPROGRAM PLC_PRG

ﬁ] File Edit Project Insert Extras Online ‘Window (= 000VAR
] aCcses0(PRG) 0003/END_VAR

| Do o5 s sp 2 L1 e .
23 FOUs

3 POUs -] ACSE50(FRG)
bl ] ACsEE0 PRE)

: ity ~ Add Cbject. .. i ACEESD
@ PLC_PRG [PRE] Renarme Objeck. ..
M e
Delete Object »y | B P TG0 (&Y. R ) (L § :

% File Edit Project Insert Extrac

Double-click and open the new program. Change “IP ADDRESS” input of the “ACS_COM_MOD_TCP_ENHANCED”
block according to the IP ADDRESS of actual drive.

% File Edit Project Insert Extras Online Window Help

0] @R wln] b[n fFemE B - o)

0001 |PROGRAM ACSEE0
3 POUs DO0ZVAR
@ ACS5850 (PRG) 0003 FBE_COM:ACS_COM_MOD_TCP_EMHANCED,
D [PRG] 0004 FB_CTRLACS_DRMES_CTRL_STAMDARD;
@ FLC_PRG [FRG] 0005 DriveData: ACS_DRINE_DATA_TYPE;
0006 ¥0Online: BOOL,
0007 aiReadvalues: ARRAY [1.12] OF INT;
0008/ EMD_VAR
| ¢
0001
FE_COM
ACS_COM_MOD_TCP_ENHANCED
TRUE—EN DONE
—H{SLOT ERRI—
'1QZ.1BB.D.12'—§A\IE_IP ERHO—
ACS_D@_ |oRIVE_TYPE BUSY—
3-{NVAR_READ ONLINE—xOnline
—{NYAR_WRITE READ_VALUES —aiReadVYalues
—{RITE_WALUES
DriveData-{DRIVE_DATA =
000z
........... FBLCTRL
ACS_DRIVES_CTRL_STAMNDARD
=0nline—EN DOME—
—{START ERR—
—STOP_EMCY_COAST ERNO—
—STOP_EMCY_RAMP READYT—
—{STOP_COAST OPERATING[—
—{RESET TRIPFED|—
—EXT_CTRL_LDC ALARME—
—{SPEED_REF EXT_RUNM_EMABLE|—
—{REF_WVALUEZ LOCAL CTRL—
DriveD ata—|{DRIVE_DATA » EXT_CTRL_LOGC_ACT|—
ACT_SPEED—
ACT_WALUEZ—
ACT_Sif—
USED_Cwi|—

Continue to add as many drives as you need. If you want to create visualization pages/objects for the additional
drives, make sure that you connect the placeholders to the function block instances for the correct program (PRG),
“ACS880” in this example.
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Other useful documentation

CODESYS Help (Contents -> Target system -> AC500 / S500 -> ACS Drives Libraries)

User’s manual Ethernet Adapter FENA-01/11
User’s manual Ethernet Adapter RETA 01
User’s manual Ethernet Adapter RETA 02

User’s manual ACS355 drives

ACS850 Firmware Manual Standard Control Program
ACQ810 Firmware Manual Standard Pump Control Program
Firmware manual ACS880 primary control program

ACSM1 Firmware Manual Speed and Torque Control
ACSM1 Firmware Manual Motion Control

User’s Manual ACS550-01 Drives

Firmware Manual ACS800 Standard Control Program

[3UA0D000093568]
[3AFE64539736]
[3AFE668895383]

[3AUA0O000066143]
[3AUA0000045497]
[3AUA0000055144]
[3AUA0000085967]
[3AFE68848270]
[3AFE68848270]
[3AUA0000001418]
[3AFE64527592]
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